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"Netscape Plugin Application Programming Interface (NPAPI) is a cross-platform plugin architecture used
by many web browsers. It was first developed for the Netscape family of browsers starting with
Netscape Navigator 2.0 but has subsequently been implemented in other browsers including Mozilla
Application Suite, Mozilla Firefox, Safari, Opera, Konqueror, Google Chrome, and some older versions of
Microsoft Internet Explorer."

Source: http://en.wikipedia.org/wiki/NPAPI

"To interact with the browser, plugins use a plugin API, such as the NPAPI [9], supported by the
browser."

Source: http://w2spconf.com/2009/papers/slpl.pdf

“The Externallnterface class is the External API, an application programming interface that enables
straightforward communication between ActionScript and the Flash Player container; for example, an

HTML page with JavaScript, or a desktop application with Flash Player embedded.

From JavaScript on the HTML page, you can call an ActionScript function in Flash Player. The
ActionScript function can return a value, and JavaScript receives it immediately as the return value of

the call.

Externallnterface is supported in the following combinations of browser and operating system: “
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3 The method of | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

claim 2, wherein | combination thereof), operate in a hypermedia network environment that includes client workstations

the communications | executing browsers which further comprises the method of claim 2, wherein the communications to

to interactively | interactively control said controllable application continue to be exchanged between the controllable
control said | application and the browser even after the controllable application program has been launched. In
controllable addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions
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application continue
to be exchanged
between the
controllable

application and the
browser even after
the controllable
application program

has been launched.

to users, and causes them to use Sun’s websites in an infringing manner in its default and expected use.

See the evidence and information cited for the claim elements 1g and 2a supra which is expressly

incorporated herein.

4pre

A method for
running an
application program
in a computer
network
environment,

comprising:

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

combination thereof), operate in a hypermedia network environment that includes client workstations

executing browsers and comprises a method for running an application program in a computer network

environment, comprising the following steps. In addition, Sun provides the infrastructure (e.g. servers,

Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s websites in an

infringing manner in its default and expected use.

See the evidence and information cited for the claim element 1pre supra which is expressly incorporated

herein.

4a

providing at least

one client

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

combination thereof), operate in a hypermedia network environment that includes at least one client
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workstation and

one network server

coupled to said
network
environment,
wherein said
network

environment is a
distributed
hypermedia

environment;

workstation and one network server coupled to said network environment, wherein said network
environment is a distributed hypermedia environment. In addition, Sun provides the infrastructure (e.g.
servers, Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s

websites in an infringing manner in its default and expected use.

See the evidence and information cited for the claim element la supra which is expressly incorporated

herein.

4b

executing, at said
client workstation,
a browser
application, that
parses a first
distributed
hypermedia
document to
identify text

formats included in

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that the client
workstation executes a browser application to parse a first distributed hypermedia document to identify
text formats included in said distributed hypermedia document for responding to predetermined text
formats to initiate processing specified by said text formats. In addition, Sun provides the infrastructure
(e.g. servers, Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s

websites in an infringing manner in its default and expected use.
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said distributed
hypermedia

document and for
responding to
predetermined text
formats to initiate

processing specified

See the evidence and information cited for the claim element 1b supra which is expressly incorporated

herein.

by said text
formats;
4c utilizing said | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

browser to display,
on said client
workstation, at
least a portion of a
first hypermedia
document received
over said network
from said server,
wherein the portion

of said first

combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that the client
workstation executes a browser application to display, on said client workstation, at least a portion of a
first hypermedia document received over said network from said server, wherein the portion of said first
hypermedia document is displayed within a first browser-controlled window on said client workstation.
In addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to
instructions to users, and causes them to use Sun’s websites in an infringing manner in its default and

expected use.
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hypermedia

document is
displayed within a
first browser-
controlled window
on said client

workstation,

See the evidence and information cited for the claim element 1c supra which is expressly incorporated

herein.

4d

wherein said first
distributed
hypermedia
document includes
an embed  text
format, located at a

first location in said

first distributed
hypermedia

document, that
specifies the

location of at least
a portion of an
object external to

the first distributed

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that said first distributed
hypermedia document includes an embed text format, located at a first location in said first distributed
hypermedia document, that specifies the location of at least a portion of an object external to the first
distributed hypermedia document. In addition, Sun provides the infrastructure (e.g. servers, Sun’s
websites, etc.), in addition to instructions to users, and causes them to use Sun’s websites in an

infringing manner in its default and expected use.

See the evidence and information cited for the claim element 1d supra which is expressly incorporated

herein.
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hypermedia
document,

4e wherein said object | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
has type | combination thereof), operate in a hypermedia network environment that includes client workstations
information executing browsers. Sun’s servers transmit a series of communications to client workstations in the
associated with it | distributed hypermedia network. Sun’s servers format the communications so that said object has type
utilized by said | information associated with it utilized by said browser to identify and locate an executable application
browser to identify | external to the first distributed hypermedia document. In addition, Sun provides the infrastructure (e.g.
and locate an | servers, Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s
executable websites in an infringing manner in its default and expected use.
application external
to the first | See the evidence and information cited for the claim element le supra which is expressly incorporated
distributed herein.
hypermedia
document,

4f and wherein said | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

embed text format

is parsed by said

combination thereof), operate in a hypermedia network environment that includes client workstations

executing browsers. Sun’s servers transmit a series of communications to client workstations in the
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browser to | distributed hypermedia network. Sun’s servers format the communications so that when said embed
automatically text format is parsed by said browser, said executable application is automatically invoked to execute on
invoke said | said client workstation in order to display said object. In addition, Sun provides the infrastructure (e.g.
executable servers, Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s
application to | websites in an infringing manner in its default and expected use.
execute on said
client workstation | See the evidence and information cited for the claim element 1f supra which is expressly incorporated
in order to display | herein.
said object

49 and enable | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
interactive combination thereof), operate in a hypermedia network environment that includes client workstations

processing of said
object within a
display area
created at said first
location within the

portion of said first

distributed
hypermedia
document being
displayed in said

executing browsers. Sun’s servers transmit a series of communications to client workstations in the

distributed hypermedia network. Sun’s servers format the communications so that interactive
processing of said object is enabled within a display area created at said first location within the portion
of said first distributed hypermedia document being displayed in said first browser-controlled window. In
addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions

to users, and causes them to use Sun’s websites in an infringing manner in its default and expected use.

See the evidence and information cited for the claim element 1g supra which is expressly incorporated

herein.
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first browser-
controlled window.
4h wherein said | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
executable combination thereof), operate in a hypermedia network environment that includes client workstations
application is a | executing browsers where said executable application is a controllable application and further comprises
controllable the following steps. In addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in
application and | addition to instructions to users, and causes them to use Sun’s websites in an infringing manner in its
further comprising | default and expected use.
the step of:
See the evidence and information cited for the claim element 2pre supra which is expressly incorporated
herein.
4i interactively Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
controlling said | combination thereof), operate in a hypermedia network environment that includes client workstations
controllable executing browsers. Sun’s servers transmit a series of communications to client workstations in the

application on said
client  workstation
via inter-process
communications
between said

browser and said

distributed hypermedia network. Sun’s servers format the communications so that interactive

controlling of said controllable application on said client workstation occurs via inter-process
communications between said browser and said controllable application. In addition, Sun provides the
infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions to users, and causes them

to use Sun’s websites in an infringing manner in its default and expected use.
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controllable See the evidence and information cited for the claim element 2a supra which is expressly incorporated
application; herein.

4j wherein the | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
communications to | combination thereof), operate in a hypermedia network environment that includes client workstations
interactively control | executing browsers. Sun’s servers transmit a series of communications to client workstations in the
said controllable | distributed hypermedia network. Sun’s servers format the communications so that communications to
application continue | interactively control said controllable application continue to be exchanged between the controllable
to be exchanged | application and the browser even after the controllable application program has been launched. In
between the | addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions
controllable to users, and causes them to use Sun’s websites in an infringing manner in its default and expected use.
application and the
browser even after | See the evidence and information cited for the claim elements 1g and 2a supra which are expressly
the controllable | incorporated herein.
application program
has been launched;
and

4k wherein additional | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
instructions for | combination thereof), operate in a hypermedia network environment that includes client workstations
controlling said | executing browsers. Sun’s servers transmit a series of communications to client workstations in the
controllable distributed hypermedia network. Sun’s servers format the communications so that the additional
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application  reside

on said network
server, wherein
said step of
interactively
controlling said
controllable

application includes
the following

substeps:

instructions for controlling said controllable application reside on said network server, wherein said step
of interactively controlling said controllable application includes the following sub-steps identified below.
In addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to
instructions to users, and causes them to use Sun’s websites in an infringing manner in its default and

expected use.

“ActionScript is the programming language for the Adobe® Flash® Player and Adobe® AIR™ run-time
environments. It enables interactivity, data handling, and much more in Flash, Flex, and AIR content

and applications.”

Source :
http://help.adobe.com/en_US/ActionScript/3.0_ProgrammingAS3/WS5b3ccc516d4fbf351e63e3d118a9b

90204-7ff4.html

“This chapter explains how to enable your SWF file to communicate with external files and other Adobe
Flash Player and Adobe AIR instances. It also explains how to load data from external sources, send
messages between a Java server and Flash Player, and perform file uploads and downloads using the

FileReference and FileReferencelist classes.”

Source: http://help.adobe.com/en_US/ActionScript/3.0 ProgrammingAS3/flash _as3 programming.pdf
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4] issuing, from the | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
client workstation, | combination thereof), operate in a hypermedia network environment that includes client workstations
one or more | executing browsers. Sun’s servers transmit a series of communications to client workstations in the
commands to the | distributed hypermedia network. Sun’s servers format the communications so that the client
network server; workstation is caused to issue one or more commands to the network server. In addition, Sun provides
the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions to users, and causes

them to use Sun’s websites in an infringing manner in its default and expected use.
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3 Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox

File  Edit  Miew Bookmarks  Tools  Help

o -c

modeling, bininformatics, biophotonics, luid dynamics, data
mining and intelligent systermns.

Hiskory

CLUMEQ Challenges
« Increase computing power and perfarmance atthe
Quebes City datacenter
» Improwve datacenter efficiency
« Implement flexible technology
+ Expand research opportunities

CLUMEQ's Results

« 10xincrease in computing resources

+ Ability to run substantially more complex simulations
and to return results mare guickly

« Substantial room to add additional capacity for future
expansion

The Sun Solution

ﬂ:f. CLUMEG, working closely with Sun
consultants, implemented a Sun
Constellatmn System, which combines
high-perfarmance computing, netwarking,
storage, and software into a fully intearated
systarm. The systerm includes Sun Blade
£048 Modular S\,rstems with Sun Blade XE275 Server odules, a

and Sun HPC software. Sun Services worked with the CLUMEG
team to provide project management, and to optimize the
_plarement of chister campnnants o maximize the conlin

‘i Iﬂ hitkp: # v, sun, comyfeatured-articles/2009-11 28 Featurefindex. jsp St - ' aoogle ‘;

Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,

Now Playing » More

Play Video

0000 05:58
(‘? get link @ get code = W3

= email

Watch and learn how Sun's HPC computing
solution helped worked for Universite
Laval

Technology History

In early 2008, Sun Microsystems, along with 1IBM, HF, and twn
other companies, responded to the CLUMEQ RFF' "'u‘\f“, te{l‘b}
hids for golutions that would specifically fitthe silo desipgedhack

remarks Patizeay. Over the course of bwo Years, an accouii ieain
frorn Sun nracontad tachhical docione to L LIMES ot tha Cue,

I

Transferring data fram receive.inplay. tubemagul. con....

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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Exemplary Evidence from Sun’s websites

3 Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox

File

O -c

Edit  Wiew Hiskory  Bookmarks  Tools  Help

muodeling, hininformatics, biophotonics, fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges

+ Increase computing power and perfarmance at the
Queber City datacenter

+ Improve datacenter efficiency

+ Implement flexible technalogy

« Expand research oppoartunities

CLUMEQ's Results

+ 10xincrease in computing resources

« Ahility to run substantially mare complex simulations
and to return results more quickly

+ Substantial room to add additional capacity for future
BXpansion

The Sun Solution

_‘F-_ CLUME®D, working closely with Sun
3 - consultants, implemented a Sun
Constellation System, which combines
high-performance computing, networking,
storage, and sofhware inta a fully integrated
_ system. The system includes Sun Blade
B048 Modular Systerms with Sun Blade XE2745 Server Modules, a
Sun Lustre Starage Systermn, Sun Datacenter InfiniBand Switches,
and Sun HPC software. Sun Services worked with the CLUMEQ
team to pravide project management, and to optimize the
nlacement of clister comonnents to maximize the conlinn

ot | @ Ihttp:Il'll'www.sun.com,ffeatured—articlesII'ZDDE-J—1128||'Feature,l'index.jsp

MNow Playing » hore

" et Direct Link to Yideo

1] = emaill & get code H_H B

0o:=0 05:58

Watch and learn how Sun's HPC computing
solution helped worked for Universite -
Laval |

Technology History

In early 2008, Sun Microsystems, alang with 186, HR, and twg
other campanies, responded to the CLUMEG RFFP. "We a‘«ﬂ*e]‘ for
bids for solutions that would specifically fit the silo desipsadback

remarks Farizeau. Cwer the course of two vears, an accouiil ieain
frorm Sun nracantad tacrkhnical dacinne to (T LIMED ot tha Sun

TransFerring data from rov-srvs.inplay. tubemogul.com. .

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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2) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox
File Edit ‘Miew History Bookmarks Tools  Help

Intro Home Wiew 4 Benefits

Front

Internals

Sun SPARC Enterprise T5140
Sun SPARC Enterprise T5240

£

|

Done

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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Edit

Exemplary Evidence from Sun’s websites
5 Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox
File

View  Histary

Bookmarks  Tools  Help

- ¢ X &

{at |_§m hitkp: f v, sun,comfservers/coolthreads/tS 140{galleryfindex. xml?p=18s=2

ﬁ ¥
View > Rear

Intro

Home View 4 DBenefits

Sun SPARC Enterprise TS140 Server

CLICK AR 1Son T

& YIEW MEDIA..,

o fILOM Service Processor

<

Read webcast-west, sun.com

3

Fall
Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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’) SunNetTalk - Mozilla Firefox
Eile Edit  Wiew  Histdry

Bookmarks  Tools  Help

ﬁ‘} IQ- http:/ fwebcast-west,sun,com/interactive/098018%4_51/

f‘j’ v| |-:'v Gr.m-.p|

Call Me Now -~
Sun Upgrade Advantage Program =

Craig Churchill

Global Director of Installed
Base Marketing,
Sun Microsystems, Inc.

__stoments [

. Introduction
- Why Should We Upgrade?
. What Are the Challenges?
. How Can Sun Help?
- Sun Upgrade Advantage
Program
. Commeon Upgrade Scenarics
. Trade-in Calculatar
. Do the Math - Step 1
= b = m 2

L S R I

[ B 1]

| 11. Conclusion

00:00/09:34 | |

View more Sun Net Talk programs:

| slide 10f 11
1] RE

oy ME

i

Cone Lt

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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) Introduction to NetBeans IDE 6.8 - Mozilla Firefox
Edit Bookmarks

Tools  Help

File

View  Hiskary

(i 0 http:finetheans, orgikb/docsfidefoverview-screencast. html

Features Plugins Docs & Support

HOME / Docs & Support

FRINTAELE VERZIOH E

etBeans IDE 6.8 Overview

The MetBeans
IDE is an
integrated
development
environment for
software
developers, It
cantains the
tools you need
to create
professional

| desktop,
enterprise, web,
and mobile
applications with
the Java
language, as
well as CAC++,
PHF, JavaScript,
Groowy, and
Ruby,

0000 0523

See what is new
and cool in the . ; 5

P PLAY B email # get link get code w3 MENL
latest MetBeans < @ )
TMFE A A the
- :

Community

(oo

T

Java Pr

Devela
Java EE

= Get Sur
Assistal

Docurm

= Generaw
>

Transferring data from rew-srw31.inplay. bubemogul.com ..

Source: http://netbeans.org/kb/docs/ide/overview-screencast.html
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) 2009 JavaOne Conference - General Session Details and Video Replays - Mozilla Firefox

File Edit Wiew Hiskory Bookmarks Tools  Help

@ ¥ c (el & http:ffiava.sun.com/fjavaone/2009 general_sessions. jsp s

General Session Details and Video Replays » Va0 BLHGR

" WISSED A GEMERAL SESSION?: Watch the replay(s) —
added shorly after broadcast.

¥ Sun General Session: Java: Change (Yjour World & |

mire details

» Sun Technical General Session: Intelligent Design: The
Pervasive Java Platform @ | more details

* Sony Ericsson General Session: Being Unique with Sony
Ericsson @ | more details

*Sun General Session: Your Java Lifestyle: Mobile, TV and

| nooo = 3403 ;
Beyond @ | more details
B oPLaY i oemal P geriink @) getoode (oD

Chapter 1. JavaCOne 2009 Opening General Ses...
The Power of & Simple ldea. Chris Melissinos welcome. Jonath ...

" Microsoft General Session: Software + Services: The Next
Application Platforin @& | more detailz

* IBM General Session: Extreme Transaction Processing

5 and Elasticity —the Answer for Your Most Demanding
Applications & | more details

" Sun General Session: James Gosling's Toy Show @& |
PSSR, mare details

Backto JavaOne Home Page View the Schedule

Transferring data from rcv-srv45.inplay. tubemogul. com....

Source: http://java.sun.com/javaone/2009/general_sessions.jsp
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#) Home - Mozilla Firefox
File Edit  Wiew

O -c

and create your own wvideo channel. and make them available in Channel Sun. A

History  Bookmarks  Tools  Help

{2 ¥ https:/ichannelsun, sun.com/indexfhome

About this Title

Blue Sky Studios use Sun Blade £
Lltra warkstations to power its cre
development environment far its |:
Age: Dawn ofthe Dinosaurs

—::IE{— Dim the Lights

0000 04:11

is Ti L8 8 &
R B oemal @ getlink & getonde o W) | MENU Rate this Title

| w _______________________________________________________ ks
< | >

Transferring data from rov-srv20.inplay, tubemogul.com. .. ‘D

Source: https://channelsun.sun.com/index/home

Page 162 of 266

*Allegation not limited to the browser in use



Claim

Claim Language

Exemplary Evidence from Sun’s websites

) SunSpectrum Bundled Training - Mozilla Firefox

File Edit ‘iew History Bookmarks Tools  Help
@ ~ C 2 G B hepyisunsolve.sun.comrichmediafi308-yT19 DOC_234281] 7 7| 2 oo

How do | set up my IPMP?
\‘“«
w -
SOoLaris

Welcome to Sun Microsystems. Thank you for using
our SunSpectrum Video Tutorial FAQs.

How Do | Set Up My IPMP?

This demonstration will perform the steps required to set up IPMP

Click the begin button to start. Begin ==

—

Copyright 2008 Sun Microsystems, Inc. All rights reserved.

(SRUC. RIS T 216 H18

Done

Source: http://sunsolve.sun.com/richmedia/0308-VT19 DOC 234281/

am

executing, on the

network server, one

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

combination thereof), operate in a hypermedia network environment that includes client workstations
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Claim Claim Language

Exemplary Evidence from Sun’s websites

or more
instructions in
response to said

commands;

executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that the network server
executes one or more instructions in response to said commands. In addition, Sun provides the
infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions to users, and causes them

to use Sun’s websites in an infringing manner in its default and expected use.
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) Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox
File Edit ‘Wiew History EBookmarks Tools  Help

O -c

madeling, bioinformatics, biophatanics, fluid dynamics, data
mining and intelligent systems.

CLUME®Q Challenges
« Increase camputing power and perfarmance at the
Quebec City datacenter
+ Improve datacenter efficiency
+ Implement flexible technalogy
+ Expand research opportunities

CLUMEQ's Results
o 10xincrease in computing resources
« Ahility to run substantially mare complex simulations
and to return results mare quickly
+ Suhstantial room to add additional capacity for future
expansion

The Sun Solution

_‘ﬁ‘ CLUME®R, working closely with Sun

- consultants, implemented a Sun
Constellation System, which comhbines
high-perfarmance computing, netwarking,
starage, and software inta a fully integrated
systermn. The systerm includes Sun Blade
6048 Modular Svstems with Sun Blade X627 Server Modules, a

and Sun HPC software. Sun Services worked with the CLUMEQ
team to provide project management, and 1o optimize the
nlacement of chister comnnnents o makimize the cnoling

Sun Lustre Storage Svystemn, Sun Datacenter InfiniBand Switches,

Exemplary Evidence from Sun’s websites

{ai I % hittp:f fena, sun. comffeatured-articles 2009-1 128 Featurefinde:x. jsp g - @' Goog|

Now Playing » Ware

Play Video

a0:00 05:58
& oemal P getlink @ st code = ")

Watch and learn how Sun's HPC computing
solution helped worked for Universite
Laval

Technology History

In eatly 2009, Sun Microsystems, along with IBM, HP, and twin
other campanies, respandad to the CLUMER RFP. "we adik] o
bids for solutions that would specifically fitthe silo desipgedhack

remarks Parizeau. Over the course of twa years, an actudii weaii
frorm Sun nrasantad tachnical dasinns to L LIMED at tha Sun.

Transferring data from receive.inplay. tubemogul.com. .

i<

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp

*Allegation not limited to the browser in use

Page 165 of 266




Claim Claim Language
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) Sun Microsystems Feature Story: CLUMED - Mozilla Firefox
Eile  Edit  Yiew Bookmarks

& -c

modeling, hioinformatics, hiophotonics, fluid dynamics, data
mining and intelligent systems.

History Tools  Help

CLUMEQ Challenges
+ Increase computing power and performance atthe
Guebec City datacenter
« |mprove datacenter efficiency
+ Implement flexible technology
+ Expand research opporunities

CLUMEQ's Results

« 10xincrease in computing resources

« Ability to run substantially more complex simulations
and to return results more quickly

+ Substantial room to add additional capacity for future
expansion

The Sun Solution

CLIUMED, working closely with Sun
consultants, implemented a Sun
Constellation Systern, which combines
high-performance computing, networking,
storage, and software into a fully integrated
systern. The systemn includes Sun Blade
G048 Modular Systems with Sun Blade XE275 Server Modules, a
Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,
and Sun HPC software. Sun Services worked with the CLUMEG
team to provide project management, and to optimize the

Transferring data from sun.edgebass.met..

i I & Ihttp:,l',l'www.sun.com,l'Featured—articles,l'ZElDQ—1128,|'Feature,|'index.jsp

Now Playing » Mare

0558

© gtcod: W)

& et link

Watch and learn how Sun’s HPC computing
solution helped worked for Universite
Laval

(] B email

Technology History

In early 2003, Sun Microsystems, along with IBM, HP, and twa
other companies, responded to the CLUMEQ RFP. "We a=Evb]* fior
hids for solutions that would specifically fit the silo des paadpack
remarks Parizeau. Over the course of two YEars, an accodii i=aim

_nlacement of clhuster comonnents toomaximize the cooling frora Suncnracantad tacknical dasinne o CLLIMED ot tha S,

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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) §un SPARC Enterprise T5140 Server Gallery - Mozilla Firefox
File Edit Mew History EBogkmarks Tools  Help
6 y c K {fat |_§m hitkp: f v, sun,comfservers/coolthreads/tS 140{galleryfindex. xml?p=18s=2 ﬂi’ g m' tica-::--glﬁ'|
Stills | 360° A
Intro Home View 4 DBenefits 4
View > Rear
Sun SPARC Enterprise TS140 Server
CLICKE AN KON T VIEW MEDIA..,
- | ~
.<. | AL ’ |
Read webcast-west, sun.com e
Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

M Fil= Edit Wiew History Bookmarks Tools  Help

ot M http: /e, sun. corny'serversicoolthreads/t5140/ gallery findex  xml?p=18s=2

Intro Home Wiew

View > Rear

: > ILOM Service Processor 00:04  00:15
Sun SPARC Enterprise T5140 Server

The ILOM service processor serial and 107100
ethernet management ports (RE), provide
management access to the server once power is
plugged into the chassis.

hd

|>

Read webcast-west, sun.com

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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’) SunNetTalk - Mozilla Firefox
Eile Edit  Wiew  Histdry

Bookmarks  Tools  Help

ﬁ‘} IQ- http:/ fwebcast-west,sun,com/interactive/098018%4_51/

f‘j’ v| |-:'v Gr.m-.p|

Call Me Now -~
Sun Upgrade Advantage Program =

Craig Churchill

Global Director of Installed
Base Marketing,
Sun Microsystems, Inc.

__stoments [

. Introduction
- Why Should We Upgrade?
. What Are the Challenges?
. How Can Sun Help?
- Sun Upgrade Advantage
Program
. Commeon Upgrade Scenarics
. Trade-in Calculatar
. Do the Math - Step 1
= b = m 2

L S R I

[ B 1]

| 11. Conclusion

00:00/09:34 | |

View more Sun Net Talk programs:

| slide 10f 11
1] RE

oy ME

i

Cone Lt

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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) SunNetTalk - Mozilla Firefox

Exemplary Evidence from Sun’s websites

File  Edit

6_,

View

History  Bookmarks  Tools  Help

c A -0 http: {fwebrast-west, sun. com/interactive/09B01894_51/
L

Sun Upgrade Advantage Program

Get Going!

« Try the Trade-In Calculator
http://www.sun.com/tradeins/calculator.jsp

@ Sun
EEVEILD [sis 200111 ] osasrosn |KHEYIS D

¥y MER ARE

Call Me Now ]

Cralg Churchill

Global Director of Installed
Base Marketing,
Sun Microsystems, Inc.

| stoments__ R

- Introduction

. Why Should We Upgrade?

. What Are the Challenges?

. How Can Sun Hefp?

. Sun Upgrade Advantage
Program

I

6. Comman Upgrade Scenarios
7. Trade-in Calculator

8. Do the Math - Step 1

5. Do the Math - Step 2

10. Get GuiE l

11. Conclusion

View more Sun Net Talk programs:

Read webcast-west. sun.com

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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#) Home - Mozilla Firefox
File Edit  Wiew

O -c

and create your own wvideo channel. and make them available in Channel Sun. A

History  Bookmarks  Tools  Help

{2 ¥ https:/ichannelsun, sun.com/indexfhome

About this Title

Blue Sky Studios use Sun Blade £
Lltra warkstations to power its cre
development environment far its |:
Age: Dawn ofthe Dinosaurs

—::IE{— Dim the Lights

0000 04:11

is Ti L8 8 &
R B oemal @ getlink & getonde o W) | MENU Rate this Title

| w _______________________________________________________ ks
< | >

Transferring data from rov-srv20.inplay, tubemogul.com. .. ‘D

Source: https://channelsun.sun.com/index/home
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) Home - Mozilla Firefox
Eile Edit ‘iew History Bookmarks Tools Help

@ bl c L (g | B nhitpsijchannelsun, sun.comfindes/home 7 ] ".'l' e |

and create your own video channel. and make them available in Channel Sun. . e

About this Title

Blue Sky Studios use Sun Blade ¢
Ultra workstations to power its cre
development environment for its L
Adge: Dawn of the Dinosaurs

-:‘é’:— Dim the Lights

04:11

0005
Rate this Title #wd*

| W S i oemail @@ getlink D getcode = WD) | MENU

£

b w W T
- >

Connected to rov-sry20.inplay. tubemogul.com...

Source: https://channelsun.sun.com/index/home
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£ SunSpectrum Bundled Training - Mozilla Firefox
File Edit ‘iew History Bookmarks Tools  Help

@ - c A Gy M http:ffsunsolve, sun,com/richmediaf0308-¥yT19_DOC_234281f

How do | set up my IPMP?
'b‘“(
w ".
SOoLaris

Welcome to Sun Microsystems. Thank you for using
our SunSpectrum Video Tutorial FAQs.

How Do | Set Up My IPMP?

This demonstration will perform the steps required to set up IPMP

Click the begin button to start. Begin ==

—

Copyright 2008 Sun Microsystems, Inc. All rights reserved.

(SR RN RIS 3

Done

Source: http://sunsolve.sun.com/richmedia/0308-VT19 DOC 234281/
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¥} SunSpectrum Bundled Training - Mozilla Firefox
File Edit Yiew History EBookmarks Tools Help

How do | set up my IPMP?

Terminal

Eile Edit Wiew Terminal Tabs Help
=

@ - c A (Y E http:ffsunsalve.sun.comfrichmediaf0308-¥T19_DOC_234251] w7 - oo

Done

Source: http://sunsolve.sun.com/richmedia/0308-VT19 DOC 234281/
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“ActionScript is the programming language for the Adobe® Flash® Player and Adobe® AIR™ run-time
environments. It enables interactivity, data handling, and much more in Flash, Flex, and AIR content
and applications.”

Source :

http://help.adobe.com/en_US/ActionScript/3.0 ProgrammingAS3/WS5b3ccc516d4fbf351e63e3d118a9b
90204-7ff4.html

“This chapter explains how to enable your SWF file to communicate with external files and other Adobe
Flash Player and Adobe AIR instances. It also explains how to load data from external sources, send
messages between a Java server and Flash Player, and perform file uploads and downloads using the
FileReference and FileReferencelList classes.”

Source: http://help.adobe.com/en_US/ActionScript/3.0 ProgrammingAS3/flash as3 programming.pdf

4n

sending information
from said network
server to said client
workstation in
response to said
executed

instructions;

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that information is sent
from said network server to said client workstation in response to said executed instructions. In
addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions

to users, and causes them to use Sun’s websites in an infringing manner in its default and expected use.
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3 Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox

File

Edit  Wiew History Bookmarks Tools  Help
@ * c ) I & hikttp: ffww, sun.comFeatured-articles 2009-1 128/ Feature findex. jsp i @ ¥ 5 F
modeling, bininformatics, hiophotonics, fluid dynamics, data Lo
mining and intelligent systems.
Now Playing » Mare
CLUMEQ Challenges
« Increase computing power and performance atthe
Quehec City datacenter
« Improve datacenter efficiency
+ Implement flexible technalogy
+ Expand research opportunities
CLUMEQ's Results Play Video
+« 10xincrease in computing resources
« Ahility to run substantially more complex simulations ]
and to return results more guickly
« Substantial room to add additional capacity for future
expansion 0000 05:58
& emal  of getlink & get code = W)
The Sun Solution Watch and learn how Sun's HPC computing
solution helped waorked for Universite
ﬁ-_ CLUMER, working closely with Sun g
consultants, implemented a Sun
Canstellation Systam, which combines
high-performance computing, networking,
| storage, and software into a fully integrated
" system. The system includes Sun Blade Technology History
G048 Modular Systerms with Sun Blade XE275 Server Modules, a In early 2009, Sun Microsystems, along with 1BM, HP, and two
Sun Lustre Storage System, Sun Datacenter InfiniBand Switches, other companies, responded to the CLUMER RFP "‘.,.'\.f: -“‘{eb]!
and Sun HPC software. Sun Services worked with the CLUMER hids for solutions that would specifically fit the silo des pgadhack
tearn to provide project management, and to optimize the remarks Parizeau, Over the course of two Years, an accouiil isai
nlacement of chister comnnnents o maximize the conling frorn Sun mracantad tarhnical dacinns to oL LIMED ot tho Sun '
Transferring data From receive.inplay. tuberiagul. con....

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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| B Sun Microsystems Feature Story: Cl... | &

- @ 0 (u | B hetpjwse.sun.comffeatured-artides(2009-1 125 featurefindex. jsp

modeling, Enfﬂrr"n’atléa}’bmp’hnlnmﬁ’s‘ fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges
+ Increase computing power and performance at the
Guehec City datacenter
+ Improve datacenter efiiciency
« Implement flexible technaology
+ Expand research opporiunities

CLUMEQ's Results
« 10xincrease in computing resources
+ Ability o run substantially more complex simulations
and to return results mare guickly
+ Substantial room to add additional capacity for future

Now Playing

» More

expansion 00:02 0552
e TNk G get coe B
B L Sun's HPC computing
Fle Edt Wiew Options Help bniversité Laval. i
»E|TAOL®REA —
ndex | Protorol | Local Address | Remote Addrass | Local...  Rem...| ServiceName | Packets| DataSis | TokalSize | Capture Time
i s r ) ol h h IBM, HF, and tiwg
3 TP 192,168.2.6  66.295.133.11 1404 80 htp 3 1717, 3,062B.. 1z/z/z00as... [[the CLU wlye askad for
4 TR 192.168.2.6  64.152.208.68 1304 a0 http 3 1,202 ... 2,238B.. 12{zfz0095... [peifcallyfitthe silo desigm
@5 uDP 192.168.2.6  192.168.1.1 s3179 53 domain 3 43Bytes SO3Bytes  1zf2/20095.. 58 ”f“’;’“éﬁm-sg a‘ﬁ‘i””g“eam
@6 TP 192.168.2.6  67.202.35.11 1405 &0 http 7 §53Bytes 1,593B.. 1z/zz0095.. [foonsio LIRS
in Menlo Park, Califarnia, and the
o7 T 192.166.2.6  67.202.35.11 1405 6o hitp 2 1,868... 3,380B... 12/2/20095...

ndex  Protocol Local Address | Remote Address

Accept-Charset: 1S0-8859-1,utf-8;q=0.7,%;q=0.7
Keep-Alive: 388
Connection: keep-alive

<

Local ...

Rem...

0, Cregon. CLUMEQ ultimately
ofthe campany's combination of

. Mchitecture, operating system

Service Mame

Packets

Datka Size

[+]

Feedback

292 Packets Captured

Source:

1) http://www.sun.com/featured-articles/2009-1128/feature/index.jsp

Capture Time

2) Smartsniff, a network monitoring utility for capturing TCP/IP packets transferred between client

workstation and network server
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Exemplary Evidence from Sun’s websites

Sun osystems Feature Story: CLUMEQ - Mo;

File Edit Yiew History Bookmarks Tools  Help

la Firefox

> c b M hkkp: fiv,sun, comffeatured-articles/2009-1128/featurejindex. jsp

Sun Microsystems Feature Story: CL... +

. LML S @ SURSI OO GO DT Or
universities in the province of Quebec, Canada, It
includes MeGill University, Université Laval, and
all nine components of the Université du Québec
network, CLUMEQ supports scientific research
in disciplines such as climate and ecosysterns
madeling, high energy patticle physics,
cosmaology, nanomaterials, supramaolecular
modeling, bininfarmatics, biophotonics, fluid dynamics, data
mining and intelligent systerns

CLUMEQ Challenges
+ Increase computing power and perfarmance at the
Guehes City datacenter
« Improve datacenter eficiency
+ Implement flexible technology
+ Expand research opportunities

CLUMEQ's Results

+ 10xincrease N computing resources

« Ahility to run substantially more complex simulations
and to return results mare guickly

+ Substantial room to add additional capacity for future
Expansion

The Sun Solution

‘ﬁ CLUMEG, warking closely with Sun

A | consultants, implemented a Sun
l ! Constellation System, which combines

high-peffarmance computing, netwarking,

| storage, and software into a fully integrated
= system. The system includes Sun Blade
6048 Modular Systems with Sun Blade X6275 Server Modules, 3
Bun Lustre Storage Systern, Sun Datacenter InfiniBand Switches,
and Sun HPC software. Sun Services worked with the CLUMER
team to pravide project management, and to optimize the
placement of cluster components to maximize the cooling
efficiency af the facility. Sun also provided a comprehensive,
custornized training and a maintenance package for the CLUMEQ
system administration team

Sun Products and Services at CLUMEQ
» 5un Blade B048 Madular Svstem
i | |

W Ahoutihe Project
» Technology History
» The Sun Solution

» More About Sun HPC Products

Now Playing » More

05:50 - 0558

mn B oemail @@ getlink @ get code

Watch and learn how sun's HPC computing
solution worked for Université Laval.

Technology History

In early 2009, Sun Microsystermns, along with IBM, HP, and twa
other companies, responded to the CLUMEQ RFP. "wWe asked for
hids for solutions thatwould specifically fit the silo design,”
remarks Parizeau. Over the course of two years, an account team
frarm Sun presented technical designs to CLUMER at the Sun
Executive Briefing Center EBC) in Menlo Park, California, and the
HPC Solution Centet in Hillsharo, Oregon. CLUMEG ultimately
decided to go with Sun because ofthe company's combination of
computing power, file system architecture, operating system
suppor, and nade management. "Sun won the bid because they
offered the best hardware and software at the best price, and its
solution fit our eriteria,” says Parizeau

[+]

Feedback

Transferring data From metrics.sun.com.

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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Exemplary Evidence from Sun’s websites
“)'§un SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

File Edit Wiew Histary  Boogkmatks  Tools

O cxa

LAY

Help

| & hittpe:f s, sun. com/fservers/coolthreads 1S 140 gallery findes. xml?p=18s=7

b

View > Rear

Al
Intro Home Wiew 4 [Benefits

Sun SPARC Enterprise T5140 Server

CLICK AN 120}

@ UIEL MEDIA..,

<

Read webcast-west, sun.com

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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Claim Claim Language Exemplary Evidence from Sun’s websites

&) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox [’;JE”E|
File Edit Wiew History Bookmarks Tools  Help

@ - c {at htkp: /v sun. comfservers/coolthreadsit5140jgalleryfindex. xmizp=18s=2 il '-.l' ",:'
Stills | 360° o
Intro Home View 4 Benefits
View > Rear
> ILOM Service Processor 00:00/ 00:15

Transferring data from webcast-west, sun.com.

- m VA EH:EA

Frotocol  Remaote Address Local Port Remaote Port Service Name Packets Diaka Size Caeture Tirne Last Packet Time
R e R i TR
P 725,124,126 2199 a0 http -] 5,297 Byltes 12j28/2009 £:51:29 PM:609 12/28/2009 6:51:29 Pr:934
£ | ¥
|
Source:

1) http://www.sun.com/servers/coolthreads/t5140/gallery/index.xml?p=1&s=2

2) Smartsniff, a network monitoring utility for capturing TCP/IP packets transferred between client

workstation and network server
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Exemplary Evidence from Sun’s websites

Fle Edit Wiew History Bookmarks  Tools  Help

View > Rear

Sun SPARC Enterprise T5140 Server

<

fat hittp: v, sun. com/servers/coolthreadst51 40/ gallery findex. xml?p=1fs=2

) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

|

Intro Horme View 4 Benefits 4

> ILOM Service Processor 00:04 / 00:15

The ILOM service processor serial and 10/100
ethemnet management ports (RG), provide
management access to the server once power is
plugged into the chassis.

Read webcast-west.sun,com

Source: http://www.sun.com/servers/coolthreads/t5140/gallery/index.xml|?p=1&s=2
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Exemplary Evidence from Sun’s websites

) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

File Edit ‘Wiew History EBookmarks Tools  Help
@ - c it http:f fena sun. comyfservers/coolthreads t5 140/ /gallery findex, xmizp=1&s=2 b
A
Intro Home Wiew 4 Benefits 4
View > Rear
2 > ILOM Service Processor 00:15
Sum SPARC Enterprise T5140 Server
= - =
The ILOM service processor serial and 10100
ethemnet management ports (R6), provide
management access to the server once power is
plugged into the chassis.
st
< [ | >
Read webcast-west,sun.com
Fy Local Port Bamnote Port Ssbyice Hame Packet Latadis Capture Time L
P FE.5.124.126 2199 80 http 1,264 1,063,548 Bytes 12/25/2009 £:51:29 PM:609 12]26/2009 6:52:38 PMi671 ]
< >
I
Source:

1) http://www.sun.com/servers/coolthreads/t5140/gallery/index.xml?p=1&s=2

workstation and network server

2) Smartsniff, a network monitoring utility for capturing TCP/IP packets transferred between client
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Exemplary Evidence from Sun’s websites

") SunietTalk - Mozilla Firefox
File Edit Mew History EBookmarks Tools  Help

‘fﬁ‘ '| m' G-Jo\;p|

(Call Me Now A
Chat Now

Craig Churchill

Global Director of Installed
Base Marketing,
Sun Microsystems, Inc.

_steuenrs R

1. Introduction

2. Why Should We Upgrade?

3. What Are the Challenges?

4. How Can Sun Help?

5. Sun Upgrade Advantage
Program

6. Comman Upgrade Scenarios

7. Trade-in Calculator

8. Do the Math - Step 1

S. Do the Math - Step 2
I 20. Gt Going! °
| 11. Conclusion P

View more Sun Net Talk programs:

Done

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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Claim Claim Language

Exemplary Evidence from Sun’s websites

2) SunMetTalk - Mozilla Firefox

File Edit ‘Wiew History Bookmarks  Tools  Help

6_.

c A -0 http:fwebcast-west, sun, comyfinter active/09601594_51/
L

Sun Upgrade Advantage Program

Get Going!

* Try the Trade-In Calculator
http://www.sun.com/tradeins/calculator.jsp

®Sun
BOBE ] == DOD KD

rowereo oy MENTORWAR

Call Me Now ]

Craig Churchill

Global Director of Installed
Base Marketing,
Sun Microsystems, Inc.

-

- Introduction

- Why Should We Upgrade?

. What Are the Challenges?

. How Can Sun Help?

. Sun Upgrade Advantage
Program

(8 T R

. Comman Upgrade Scenarios
- Trade-in Calculatar

. Do the Math - Step 1

S. Do the Math - Step 2

10. Get Gui@i ' |
Q

11. Conclusion

e o~ o

View more Sun Net Talk programs:

Read webcast-west, sun.com

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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Exemplary Evidence from Sun’s websites

Chat Now

Craig Churchill

Glohal Director of Installed
Base Marketing,

Sun Microsystems, Inc.

Get Going!

= Try the Trade-In Calculator
http://www.sun.com/tradeins/calculator.jsp [ seoments |

1. Introduction

2. Why Should We Upgrade?
N " “rhat Now?’ 3. What Are the Challenges?

5

- How Can Sun Help?
. Sun Upgrade Advantage
Program
6. Common Upgrade Scenarios
7. Trade-in Calculator
8. Do the Math - Step 1
9. Do the Math - Step 2

@

) 11, lusi {
@‘.SHH Conclusion o

E a m | siide 10011 o8a7/09:30 ]n n n

TransFerring cask-west

87 SmartSniff
il File Edit View Options Help

bm T A EBEA

Protocol | Remote Address Local Port Remaote Pork Service Name Packets Data Size Capture Time

23 PM:206

|GET /interactive/B9B61894 51/sunnetuapdB.swf HTTP/1.1
Source:
1) http://webcast-west.sun.com/interactive/09B01894_ 51/

2) Smartsniff, a network monitoring utility for capturing TCP/IP packets transferred between client

workstation and network server
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Exemplary Evidence from Sun’s websites

) Home - Mozilla Firefox
File Edit  “iew

& -c

and create your own wvideo channel. and make them available in Channel Sun. A~

History  Bookmarks  Tools  Help

ot ! https:f{channelsun. sun.comindesxhome

About this Title

Blue Sky Studios use Sun Blade ¢
Ultra wworkstations to power its cre
development ervironment for its
Age: Dawn of the Dinosaurs

—:tli!f— Dim the Lights

0000 04:11

is Ti L8 8 & 3
B PLAY % emal P getink @@ get code o WD | MENU Rate this Title

W W T
< | >
TransFerring data from rew-srv20.inplay. bubemogul.com.... o

Source: https://channelsun.sun.com/index/home

*Allegation not limited to the browser in use

Page 186 of 266




Claim

Claim Language

Exemplary Evidence from Sun’s websites

) Home - Mozilla Firefox
Eile Edit ‘iew History Bookmarks Tools Help

@ bl c L (g | B nhitpsijchannelsun, sun.comfindes/home 7 ] ".'l' e |

and create your own video channel. and make them available in Channel Sun. . e

About this Title

Blue Sky Studios use Sun Blade ¢
Ultra workstations to power its cre
development environment for its L
Adge: Dawn of the Dinosaurs

-:‘é’:— Dim the Lights

04:11

0005
Rate this Title #wd*

| W S i oemail @@ getlink D getcode = WD) | MENU

£

b w W T
- >

Connected to rov-sry20.inplay. tubemogul.com...

Source: https://channelsun.sun.com/index/home
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Exemplary Evidence from Sun’s websites

£ SunSpectrum Bundled Training - Mozilla Firefox
File Edit ‘iew History Bookmarks Tools  Help

@ - c A Gy M http:ffsunsolve, sun,com/richmediaf0308-¥yT19_DOC_234281f

How do | set up my IPMP?
'b‘“(
w ".
SOoLaris

Welcome to Sun Microsystems. Thank you for using
our SunSpectrum Video Tutorial FAQs.

How Do | Set Up My IPMP?

This demonstration will perform the steps required to set up IPMP

Click the begin button to start. Begin ==

—

Copyright 2008 Sun Microsystems, Inc. All rights reserved.

(SR RN RIS 3

Done

Source: http://sunsolve.sun.com/richmedia/0308-VT19 DOC 234281/
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Exemplary Evidence from Sun’s websites

“ActionScript is the programming language for the Adobe® Flash® Player and Adobe® AIR™ run-time
environments. It enables interactivity, data handling, and much more in Flash, Flex, and AIR content
and applications.”

Source :

http://help.adobe.com/en_US/ActionScript/3.0 ProgrammingAS3/WS5b3ccc516d4fbf351e63e3d118a9b
90204-7ff4.html

“This chapter explains how to enable your SWF file to communicate with external files and other Adobe
Flash Player and Adobe AIR instances. It also explains how to load data from external sources, send
messages between a Java server and Flash Player, and perform file uploads and downloads using the
FileReference and FileReferencelList classes.”

Source: http://help.adobe.com/en_US/ActionScript/3.0 ProgrammingAS3/flash as3 programming.pdf

40

and processing said
information at the
client  workstation
to interactively
control said
controllable

application.

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that the client
workstation processes said information at the client workstation to interactively control said controllable
application. In addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition
to instructions to users, and causes them to use Sun’s websites in an infringing manner in its default

and expected use.
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Exemplary Evidence from Sun’s websites

) Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox
File  Edit  Wiew Bookmarks

O -c

muodeling, bioinformatics, hiophotonics, fluid dynamics, data
mining and intelligent systems.

Hiskory Tools  Help

CLUMEQ Challenges

Increase computing power and pedarmance atthe
Quehec City datacenter

Improve datacenter efficiency

Implement flexible technology

+ Expand research opporunities

CLUMEQ's Results

+ 10xincrease in computing resources

+ Ahility to run substantially mare complex simulations
and ta return results more guickly

+ Suhstantial room to add additional capacity for future
expansion

*

*

+

The Sun Solution

F-_ CLUME®R, working closely with Sun
consultants, implemented a Sun
Constellation System, which combines
high-perfarmance computing, netwarking,
starage, and software into a fully integrated
systemn. The system includes Sun Blade
6048 Madular S\,rstems with Sun Blade X6275 Server Modules, a

and Sun HFC software. Sun Services warked with the CLUMEG
teamn to provide project management, and to optimize the
nlacement of cliuster comonnents o maximize the conling

2% I ﬂ hitbp: ) feman sun. comyfeatured-articles2009-1 128 Featurefindex. jsp S.7 -

Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,

Mow Playing # Mare

Play Video

0000

0558
o)

@ get code

& oemal @ aetlink
Watch and learn how Sun's HPC computing
solution helped worked for Universite
Laval

Technology History

In eatly 2009, Sun Microsystems, along with (BM, HP, and two
other companies, responded to the CLUMEQ RFFP. “wie a+] i
bids for solutions that would specifically fit the silo des pgadhack

rermarks Parizeau. Overthe course of bwa years, an accodiiisaim
frorn Sun nrasantad tachnical dasions to T LIMED at tha Sun

Transferring data from receive,inplay, tubemogul.com....

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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Exemplary Evidence from Sun’s websites

File

"

Sun Microsystems Feature Story: CLUMEQ - Mozilla

Edit  Wiew History Bookmarks  Tools  Help

d C

modeling, bioinformatics, biophotonics, fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges

Increase computing power and performance at the
GQuebec City datacenter

Imprave datacenter efficiency
Implement flexible technology

« Expand research opporunities

CLUMEQ’s Results
+ 10xincrease in camputing resources
+ Ability to run substantially mare complex simulations
and to return results more guickly
+ Substantial room to add additional capacity for future
expansion

The Sun Solution

‘Fﬂ_ CLUME®, warking closely with Sun
- | consultants, implemented a Sun
Constellation Systern, which combines
high-performance computing, networking,
storage, and software into a fully integrated
4 system. The system includes Sun Blade
6048 Modular Systems with Sun Blade 6275 Server Modules, a
Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,
and Sun HPC software. Sun Services worked with the CLUMEQ
team to pravide project management, and to aptimize the
nlarement of cluster comnnnents o makimize the conlinn

{2t I M 'http:,l’,l’www.sun.com,l’Featured—articlesIZDDQ-1128,|’Feature,|’inde><.jsp

Mow Playing » Mare

- = 05:58
1] & oemail P getiink @ get code L B

Watch and learn how Sun’s HPC computing
solution helped worked for Universite

Laval J

Technology History

In eatly 2009, Sun Microsystems, along with IBM, HP, and two
other companies, responded to the CLUMEQ RFP. "We ﬁﬁrb]l {al}
hids for solutions that would specifically fit the silo despaadback
remarks Parizeau. Over the course of two years, an accouiii ieain
frorn Sun tad tachni L i to L LIMED at tha Sk

Transferring data From sun.edgeboss.net...

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.isp
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Edit

Exemplary Evidence from Sun’s websites
5 Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox
File

View  Histary

Bookmarks  Tools  Help

- ¢ X &

{at |_§m hitkp: f v, sun,comfservers/coolthreads/tS 140{galleryfindex. xml?p=18s=2

ﬁ ¥
View > Rear

Intro

Home View 4 DBenefits

Sun SPARC Enterprise TS140 Server

CLICK AR 1Son T

& YIEW MEDIA..,

o fILOM Service Processor

<

Read webcast-west, sun.com

3

Fall
Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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Exemplary Evidence from Sun’s websites

) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

M Fil= Edit Wiew History Bookmarks Tools  Help

ot M http: /e, sun. corny'serversicoolthreads/t5140/ gallery findex  xml?p=18s=2

Intro Home Wiew

View > Rear

: > ILOM Service Processor 00:04  00:15
Sun SPARC Enterprise T5140 Server

The ILOM service processor serial and 107100
ethernet management ports (RE), provide
management access to the server once power is
plugged into the chassis.

hd

|>

Read webcast-west, sun.com

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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Exemplary Evidence from Sun’s websites

’) SunNetTalk - Mozilla Firefox
Eile Edit  Wiew  Histdry

Bookmarks  Tools  Help

ﬁ‘} IQ- http:/ fwebcast-west,sun,com/interactive/098018%4_51/

f‘j’ v| |-:'v Gr.m-.p|

Call Me Now -~
Sun Upgrade Advantage Program =

Craig Churchill

Global Director of Installed
Base Marketing,
Sun Microsystems, Inc.

__stoments [

. Introduction
- Why Should We Upgrade?
. What Are the Challenges?
. How Can Sun Help?
- Sun Upgrade Advantage
Program
. Commeon Upgrade Scenarics
. Trade-in Calculatar
. Do the Math - Step 1
= b = m 2

L S R I

[ B 1]

| 11. Conclusion

00:00/09:34 | |

View more Sun Net Talk programs:

| slide 10f 11
1] RE

oy ME

i

Cone Lt

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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2) SunNetTalk - Mozilla Firefox
File Edit Wiew History Bookmarks

Exemplary Evidence from Sun’s websites

Help

Get Going!

rowenes ay MENTORW ARE

* Try the Trade-In Calculator
http://www.sun.com/tradeins/calculator.jsp

+]5] 7 |« | CXTMETTEY ¢ o] ») o )

Craig Churchill

Global Director of Installed
Base Marketing,
Sun Micrasystems, Inc.

| stomens [

- Introduction

. Why Should We Upgrade?

. What Are the Challenges?

. How Can Sun Hefp?

. Sun Upgrade Advantage
Program

L R

6. Comman Upgrade Scenarios
7. Trade-in Calculator

8. Do the Math - Step 1

S. Do the Math - Step 2

(70, Get Gong') ®
., 11. Conclusk |
@lszfﬁ onclusion ™

View more Sun Net Talk programs:

Read webcast-west.sun.com

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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Exemplary Evidence from Sun’s websites

) Introduction to NetBeans IDE 6.8 - Mozilla Firefox
Edit Bookmarks

Tools  Help

File

View  Hiskary

(i 0 http:finetheans, orgikb/docsfidefoverview-screencast. html

Features Plugins Docs & Support

HOME / Docs & Support

FRINTAELE VERZIOH E

etBeans IDE 6.8 Overview

The MetBeans
IDE is an
integrated
development
environment for
software
developers, It
cantains the
tools you need
to create
professional

| desktop,
enterprise, web,
and mobile
applications with
the Java
language, as
well as CAC++,
PHF, JavaScript,
Groowy, and
Ruby,

0000 0523

See what is new
and cool in the . ; 5

P PLAY B email # get link get code w3 MENL
latest MetBeans < @ )
TMFE A A the
- :

Community

(oo

T

Java Pr

Devela
Java EE

= Get Sur
Assistal

Docurm

= Generaw
>

Transferring data from rew-srw31.inplay. bubemogul.com ..

Source: http://netbeans.org/kb/docs/ide/overview-screencast.html
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Exemplary Evidence from Sun’s websites

’} Introduction to NetBeans IDE 6.8 - Mozilla Firefox
Fle Edit Wiew History Bookmarks Tools  Help

6 < c m, ot 'D http:ffnetbeans. argikb/docsfide/overview-screencast. hkml

HOME § Docs & Suppart

lletBeans IDE 6.8 Overview

FRINTRELE LERSION 5

The MetBeans
ICE is an
integrated
development
environment for
software
developers. It
contains the
tools you need
to create
professional
desktop,
enterprise, weh,
and mobile
applications with
the Java
language, as
well as C/C++,
FPHF, JavaScript,
Groovy, and

Ruby.
See what is new s -
and cool in the Il Pause emiail

latest NetBeans

Announcing

@ get link Q gt code

0623

= ®3 | MENU

TMF A 8 the
<

= Java:PE

Develo
Java EE

= Get Sur
fssistal

Transferring data from sun.edgeboss.net...

Source: http://netbeans.org/kb/docs/ide/overview-screencast.html
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Exemplary Evidence from Sun’s websites

) 2009 JavaOne Conference - General Session Details and Video Replays - Mozilla Firefox

File Edit Wiew Hiskory Bookmarks Tools  Help

@ ¥ c (el & http:ffiava.sun.com/fjavaone/2009 general_sessions. jsp s

General Session Details and Video Replays » Va0 BLHGR

" WISSED A GEMERAL SESSION?: Watch the replay(s) —
added shorly after broadcast.

¥ Sun General Session: Java: Change (Yjour World & |

mire details

» Sun Technical General Session: Intelligent Design: The
Pervasive Java Platform @ | more details

* Sony Ericsson General Session: Being Unique with Sony
Ericsson @ | more details

*Sun General Session: Your Java Lifestyle: Mobile, TV and

| nooo = 3403 ;
Beyond @ | more details
B oPLaY i oemal P geriink @) getoode (oD

Chapter 1. JavaCOne 2009 Opening General Ses...
The Power of & Simple ldea. Chris Melissinos welcome. Jonath ...

" Microsoft General Session: Software + Services: The Next
Application Platforin @& | more detailz

* IBM General Session: Extreme Transaction Processing

5 and Elasticity —the Answer for Your Most Demanding
Applications & | more details

" Sun General Session: James Gosling's Toy Show @& |
PSSR, mare details

Backto JavaOne Home Page View the Schedule

Transferring data from rcv-srv45.inplay. tubemogul. com....

Source: http://java.sun.com/javaone/2009/general_sessions.jsp
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